
Škoda Fabia
CenCenníkník

Zistite viac

Motor PalivPalivoo PrPreevvodoodovkavka PohonPohon Essence Selection Top Selection

1.0 MPI 59 kW (80 k) Benzín 5° MP predný 15 330 15 850 17 620
1.0 TSI 70 kW (95 k) Benzín 5° MP predný 16 030 16 550 18 320
1.0 TSI 85 kW (116 k) Benzín 6° MP predný 16 330 16 850 18 620
1.0 TSI 85 kW (116 k) Benzín 7° AP DSG predný - 18 350 20 120
1.5 TSI 110 kW (150 k) Benzín 7° AP DSG predný - 20 090 21 860
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Prečo práve Fabia?

Neprehliadnuteľná

Škoda Fabia ponúka už v štandardnej výbave predné a zadné
svetlomety s LED technológiou. Na prianie môžete získať tiež Full
LED predné svetlomety

Bezpečná

O bezpečnosť posádky vozidla sa postará až 9 airbagov a s balíkmi
Assisted Drive získate na cestách ďalšiu úroveň bezpečnosti a
komfortu.

Priestranná

Fabia disponuje veľkorysým objemom batožinového priestoru, ktorý
sa s hodnotou 380 l zaraďuje nad priemer vo svojej triede. Zaručene
tiež poteší medzigeneračný nárast priestoru pre cestujúcich vzadu, a
to pozdĺžne aj na šírku.

Monte Carlo

Najvyšší výbavový stupeň Monte Carlo prináša exkluzívne dizajnové
prvky v interiéri a exteriéri. Vďaka príplatkovému športovému
podvozku a výkonným benzínovým motorom si užijete s vozidlom
zábavnú a dynamickú jazdu.

Vyberte si svoj interiér

Loft Lodge

Suite Dynamic
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Základná výbava

Interiér Studio

Oceľové disky kolies 5,5J x 15" s krytmi Callisto (185/65 R15)

Zadné kotúčové brzdy (len pre 1.0 TSI 85kW )

ESC vrátane ABS, MSR, ASR, EDS, HBA, XDS

Airbag vodiča a spolujazdca, airbag spolujazdca s deaktiváciou

Hlavové airbagy a bočné airbagy vpredu

Front Assist – výstraha pred kolíziou a podpora núdzového brzdenia
a Pedestrian Monitor (ochrana chodcov)

ISOFIX a Toptether pre sedadlo spolujazdca

3. hlavová opierka vzadu

Lane Assist – asistent udržiavania v jazdnom pruhu

Driver Alert - asistent rozpoznania únavy

Easy Light Assist – svetelný senzor

Kontrola tlaku v pneumatikách

LED hlavné svetlomety + LED denné svietenie

Predné hmlové svetlomety

Centrálne zamykanie s diaľkovým ovládaním (2 sklopné kľúče)

Infotainment Škoda s 8" dotykovým displejom

4 reproduktory vpredu

DAB – digitálny rádiopríjem

Bluetooth

8" virtuálny kokpit

Čítanie dopravných značiek

2-ramenný PUR volant

Parkovacie senzory vzadu

Elektricky nastaviteľné a vyhrievané vonkajšie spätné zrkadlá,
lakované vo farbe karosérie

Elektrické ovládanie okien vpredu

Obmedzovač rýchlosti

Manuálna klimatizácia

Funkčný paket: 3 stropné madlá (zadné s háčikmi), slnečné clony
s Make-up zrkadlom na strane vodiča a spolujazdca, schránka
na okuliare, lampičky na čítanie vpredu a vzadu

Zadné sedadlá nedelené, zadné operadlá delené a sklopné v pomere
60:40

Tyre Fit – súprava na opravu pneumatík

e-Call - tiesňové volanie

Proaktívny servis na 10 rokov

Predĺžená záruka na 5 rokov/100 000 km

ŠKODA – Doživotná Garancia Mobility Premium - Poskytuje pomoc
servisným vozidlom na mieste poruchy (porucha na vozidle,
chýbajúce PHM, defekt pneumatiky, zabuchnuté/stratené kľúče,
vybitá batéria, zámena paliva), odtiahnutie vozidla, prípadne služby –
náhradnú dopravu, požičanie náhradného vozidla, ubytovanie
pre posádku a i.

Interiér Loft

Poťah prístrojovej dosky Látka Kota Grey

Disky Proxima z ľahkej zliatiny 6J × 16" – strieborné (iba
pre 1.5 TSI 110 kW)

Zadné kotúčové brzdy (len pre 1.0 TSI 85 kW a 1.5 TSI 110 kW)

Full LED zadné svetlá

Asistent rozjazdu do kopca

Easy Start - centrálne zamykanie s diaľkovým ovládaním
a štartovaním tlačidlom, bez Safe systému

2 reproduktory vzadu

Bezdrôtový Smartlink

2-ramenný kožený multifunkčný volant

Výškovo nastaviteľné sedadlo vodiča

Tempomat s obmedzovačom rýchlosti

Úložné vrecká na zadnej strane operadiel predných sedadiel

Dáždnik vo výplni dverí vodiča

Chrómované ovládače prívodu vzduchu a rámčeky prívodu vzduchu
v interiéri

Interiér Lodge

Disky Proxima z ľahkej zliatiny 6J × 16" – strieborné

Predné hmlové svetlomety s corner funkciou

Výškovo nastaviteľné predné sedadlá s manuálne nastaviteľnými
bedrovými opierkami

Vyhrievanie predných sedadiel s oddelenou reguláciou

Ukazovateľ stavu kvapaliny v ostrekovači

Vyhrievané trysky ostrekovačov

Ambietné osvetlenie prepínateľné biela/červená

Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie spätné
zrkadlá s automatickým stmievaním na strane vodiča

Sunset – sklá s vyšším stupňom tónovania od B‑stĺpika

Lakťová opierka vpredu

Vnútorné spätné zrkadlo s automatickým stmavovaním

Climatronic – dvojzónová automatická klimatizácia so senzorom
vlhkosti a kombi filtrom

Elektrické ovládanie okien vpredu a vzadu

Dažďový senzor

2-ramenný vyhrievaný kožený multifunkčný volant

Vkladané tkané koberce vpredu a vzadu

Podokenná chrómová lišta

Nástupné prahové lišty s názvom Fabia

Essence

Selection (navyše oproti Essence)

Top Selection (navyše oproti Selection)
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Doplnková výbava

Selection Plus › Disky z ľahkej zliatiny Rotare 5,5J x 15" s Aero krytmi -
strieborné (pneu 185/65 R15)

› Vkladané tkané koberce vpredu a vzadu
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› Stredová konzola s držiakom na nápoje typu Snehuliak
› Výškovo nastaviteľné predné sedadlá s manuálne nastaviteľnými

bedrovými opierkami
› Elektrické ovládanie okien vzadu

(nie je možné s PUV/WQ3/WQ6/WQ8 a pre 1.5 TSI 110 kW)

WSA 399

Disky z ľahkej zliatiny Rotare 5,5J x 15" s Aero krytmi - čierne lesklé
(cena platí iba v kombinácii s paketom WSA)

PJ3 − 112 −

Disky z ľahkej zliatiny Proxima 6J x 16" - strieborné (pneu 195/55 R16)
(cena platí iba v kombinácii s paketom WSA)

PJ4 − 463 −

Disky z ľahkej zliatiny Proxima Aero 6J x 16" - čierne lesklé (pneu 195/55 R16)
(cena platí iba v kombinácii s paketom WSA)

PJ5 − 629 −

Disky z ľahkej zliatiny Proxima Aero 6J x 16" - sivé (pneu 195/55 R16)
(cena platí iba v kombinácii s paketom WSA)

PJ6 − 629 −

Disky z ľahkej zliatiny Ursus 6J x 16" - čierne (pneu 195/55 R16)
(cena platí iba v kombinácii s paketom WSA)

PJ0 − 731 −

Essence Selection Top SelectionAkčné pakety Plus

Essence Selection Top SelectionKombinačné ceny pre akčné pakety
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Assisted Drive › Adaptívny tempomat do 210 km/h
› Adaptive Lane Assist - adaptívne vedenie v pruhu
(nie je možné pre 1.0 MPI 59 kW)

PUE − 406 406

Assisted Drive Plus › Navyše oproti Assited Drive:
› Side Assist
› Vnútorné spätné zrkadlo s automatickým stmavovaním
› Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie spätné

zrkadlá s automatickým stmievaním na strane vodiča
› Light and Rain Assist - svetelný a dažďový senzor
› Predné hmlové svetlomety s funkciou corner
(nie je možné pre 1.0 MPI 59 kW)

PUF − 1024 690

Assisted Drive
Premium

› Navyše oproti Assited Drive Plus:
› Full LED predné svetlomety s LED denným svietením a LED

corner funkciou
(nie je možné pre 1.0 MPI 59 kW)

PU3 − 1597 1333

Light & View › Vnútorné spätné zrkadlo s automatickým stmavovaním
› Elektricky nastaviteľné, vyhrievané a sklopné vonkajšie spätné

zrkadlá s automatickým stmievaním na strane vodiča
› Light and Rain Assist - svetelný a dažďový senzor
› Predné hmlové svetlomety s funkciou corner

PUM − 359 •

Light & View Plus › Navyše oproti Light&View:
› Full LED predné svetlomety s LED denným svietením a LED

corner funkciou

PUN − 973 613

Safety paket › Kolenný airbag
› Bočné airbagy vzadu

PE4 458 458 458

Asistent rozjadu do kopca UG1 82 • •

Transport › Cargo Elementy
› Multifunkčná kapsa so zadným platom
› Sieťový program
› Obojstranný koberec v batožinovom priestore (guma/látka)

PUP 109 109 109

Transport s dvojitou
podlahou

› Cargo Elementy
› Multifunkčná kapsa so zadným platom
› Sieťový program
› Obojstranný koberec v batožinovom priestore (guma/látka)
(možné len s 3GD)

PUQ − 94 94

Family › Odpadkový kôš
› Odkladací priestor s flexibilným držiakom na zadnom tuneli
› Lakťová opierka vzadu
› Držiak na tablet

PUR − 134 134

Paket na zlé cesty (nie je možné s 17"/18" diskami kolies a pre motorizáciu 1.5 TSI 110kW) PK4 195 195 195

Výsuvné integrované ostrekovače svetlometov, ukazovateľ hladiny kvapaliny v nádobe
na ostrekovače

PK5 158 158 158

Príprava pre ťažné zariadenie (nie je možné s WC2) PTX − 116 116

Ťažné zariadenie – odnímateľné (nie je možné s WC2) PTZ − 522 522

Ťažné zariadenie – odnímateľné s adaptérom (nie je možné s WC2) PTY − 560 560

Fajčiarsky paket (popolník vpredu a zapaľovač) 9JD 29 29 29

Dvojitá podlaha v batožinovom priestore (možné len s PUQ) 3GD − 146 146

Športový podvozok PSP − 143 143

Essence Selection Top SelectionBezpečnosť

Essence Selection Top SelectionFunkčnosť
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Lodge › Látkové sedadlá Lodge
› Ambietné osvetlenie prepínateľné biela/červená
› Poťah prístrojovej dosky Látka Nuba Grey s prešívaním
› Chrómové orámovanie výduchov ventilácie
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› 4 LED lampičky na čítanie
› Výškovo nastaviteľné sedadlo spolujazdca
› Manuálne nastaviteľné bedrové opierky
› Elektrické ovládanie okien vzadu

WQ3 − 608 •

Suite › Látkové sedadlá Lodge s prvkami Copper
› Ambietné osvetlenie prepínateľné biela/červená
› Poťah prístrojovej dosky Látka Nuba Copper s prešívaním
› Chrómové orámovanie výduchov ventilácie
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› 4 LED lampičky na čítanie
› Výškovo nastaviteľné sedadlo spolujazdca
› Manuálne nastaviteľné bedrové opierky
› Elektrické ovládanie okien vzadu

WQ6 − 608 −

Dynamic › Športové látkové sedadlá
› Poťah prístrojovej dosky Látka Dynamic
› Ambietné osvetlenie prepínateľné biela/červená
› Ozdobné kryty pedálov z ušľachtilej ocele
› Vkladané tkané koberce vpredu a vzadu
› 3-ramenný športový kožený multifunkčný volant
› Chrómové orámovanie výduchov ventilácie
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› Výškovo nastaviteľné sedadlo spolujazdca
› Manuálne nastaviteľné bedrové opierky
› Elektrické ovládanie okien vzadu

WQ8 − 740 −

2-ramenný multifunkčný PUR volant PL0 141 − −

2-ramenný kožený multifunkčný volant PLB 383 • −

2-ramenný kožený multifunkčný volant s ovládaním DSG prevodovky PLC − 99 −

2-ramenný vyhrievaný kožený multifunkčný volant (možné len s PHB/PUH/PUI) PLD − 106 •

2-ramenný vyhrievaný kožený multifunkčný volant s ovládaním DSG prevodovky (možné len
s PHB/PUH/PUI)

PLE − 180 180

3-ramenný športový kožený multifunkčný volant PLF − 95 −

3-ramenný športový kožený multifunkčný volant s ovládaním DSG prevodovky PLG − 226 −

3-ramenný športový vyhrievaný kožený multifunkčný volant (možné len s PHB/PUH/PUI) PLH − 200 200

3-ramenný športový vyhrievaný kožený multifunkčný volant s ovládaním DSG prevodovky
(možné len s PHB/PUH/PUI)

PLI − 275 275

Essence Selection Top SelectionVolanty / interiéry / sedadlá
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Disky z ľahkej zliatiny Rotare 5,5J x 15" s Aero krytmi - strieborné (pneu 185/65 R15) PJ2 600 600 −

Disky z ľahkej zliatiny Rotare 5,5J x 15" s Aero krytmi - čierne lesklé (pneu 185/65 R15) PJ3 − 712 −

Disky z ľahkej zliatiny Proxima 6J x 16" - strieborné (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ4 1063 1063 / • •

Disky z ľahkej zliatiny Proxima Aero 6J x 16" - čierne lesklé (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ5 − 1229 / 167 167

Disky z ľahkej zliatiny Proxima Aero 6J x 16" - sivé (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ6 − 1229 / 167 167

Disky z ľahkej zliatiny Ursus 6J x 16" - čierne (pneu 195/55 R16)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ0 − 1331 / 268 268

Disky z ľahkej zliatiny Procyon 7J x 17" - strieborné (pneu 215/45 R17)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ7 − 1526/ 463 463

Disky z ľahkej zliatiny Procyon Aero 7J x 17" - čierne lesklé (pneu 215/45 R17)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ8 − 1690 / 627 627

Disky z ľahkej zliatiny Procyon Aero 7J x 17" - sivé (pneu 215/45 R17)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJ9 − 1690 / 627 627

Disky z ľahkej zliatiny Libra 7J x 18" - čierne (pneu 215/40 R18) (nie je možné pre 1.0 MPI
59 kW)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PJF − 2314/ 1251 1251

Rezervné koleso (neplnohodnotné) pre 15" disky + zdvihák +klúč na kolesá PJA 129 129 −

Rezervné koleso (dojazdové) pre 16", 17" a 18" disky + zdvihák +klúč na kolesá PJB 129 129 129

Comfort › Vkladané tkané koberce vpredu a vzadu
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› Stredová konzola s držiakom na nápoje typu Snehuliak
› Výškovo nastaviteľné sedadlo vodiča
(nie je možné s 9JD)

PU0 206 − •

Comfort Plus › Vkladané tkané koberce vpredu a vzadu
› Lakťová opierka vpredu s odkladacou schránkou Jumbo Box

a výduchmi ventilácie pre cestujúcich vzadu
› Stredová konzola s držiakom na nápoje typu Snehuliak
› Výškovo nastaviteľné predné sedadlá s manuálne nastaviteľnými

bedrovými opierkami
› Elektrické ovládanie okien vzadu
(nie je možné s WQ3/WQ6/WQ8)

PUV − 384 •

Park & Go › Zadná parkovacia kamera s ostrekovačom
› Drive Mode Select
› KESSY
› Predné parkovacie senzory
(nie je možné pre 1.0 MPI 59 kW)

PUA − 594 594

Park & Go Plus › Naviac oproti Park & Go:
› Park Assist – parkovací asistent
(nie je možné pre 1.0 MPI 59 kW)

PUC − 672 672

Park & Go (so Safe
Systémom a Alarmom)

› Zadná parkovacia kamera s ostrekovačom
› Drive Mode Select
› KESSY so Safe Systémom
› Alarm
› Predné parkovacie senzory
(nie je možné pre 1.0 MPI 59 kW)

PUB − 751 751

Park & Go Plus (so Safe
Systémom a Alarmom)

› Naviac oproti Park & Go:
› Park Assist – parkovací asistent
(nie je možné pre 1.0 MPI 59 kW)

PUD − 804 804

Parkovacie senzory vpredu 7X2 − 336 336

Parkovacia kamera s ostrekovačom KA1 − 289 289

Essence Selection Top SelectionDisky / pneumatiky

Essence Selection Top SelectionKomfort
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Winter › Vyhrievané predné sedadlá
› Ukazovateľ stavu kvapaliny v ostrekovači
› Vyhrievané trysky ostrekovačov čelného skla

PUG − 221 •

Winter Plus › Naviac oproti Winter:
› Climatronic – dvojzónová automatická klimatizácia so senzorom

vlhkosti a kombi filtrom
› Vnútorné spätné zrkadlo s automatickým stmavovaním
(iba s PLD, PLE, PLH, PLI)

PUH − 482 •

Winter Premium › Naviac oproti Winter Plus:
› Vyhrievané čelné sklo
(iba s PLD, PLE, PLH, PLI)

PUI − 586 137

Chrome › Sunset – sklá s vyšším stupňom tónovania od B‑stĺpika
› Podokenná chrómová lišta
› Nástupné prahové lišty na prahoch dverí

PUJ − 244 •

Design › Naviac oproti Chrome:
› Disky z ľahkej zliatiny 16“ Ursus – čierne leštené
(možné len s YCA)
(cena okrem 1.5 TSI 110 kW /pre 1.5 TSI 110 kW)

PB1 − 1158 / 426 185

Adaptive Cruise Control – adaptívny tempomat do 210 km/h (nie je možné pre 1.0 MPI
59 kW)

PL2 − 299 299

Sunset – sklá s vyšším stupňom tónovania od B‑stĺpika 4KF − 158 •

Open Sky › Panoramatická strecha
› 4 stropné madlá
› bez schránky na okuliare
› bez skladacej slnečnej clony

WGS − 1093 1093

Climatronic – dvojzónová automatická klimatizácia so senzorom vlhkosti a kombi filtrom PHB − 380 •

Operadlo predného sedadla spolujazdca sklopné do vodorovnej polohy 3H2 − 95 95

Technology › 2 reprodktory vzadu
› Bezdrôtový Smartlink

WUS 300 • •

Navi paket › Škoda Navigation s 9,2" dotykovým displejom
› Virtuálny kokpit – 10" digitálny prístrojový panel s nastaviteľným

zobrazovaním údajov
› Hlasové ovládanie
› Care Connect + Infotainment online služby na 3 roky

WNA − 1237 1237

Charging › Phonebox
› 2 x USB-C vzadu
› USB-C v držiaku vnútorného spätného zrkadla
(možné iba s WQ3/WQ6/WQ8/PUV)

PU2 − 286 286

Virtuálny kokpit – 10" digitálny prístrojový panel s nastaviteľným zobrazovaním údajov 9S0 − 453 453

Sound Systém Škoda - Škoda Soundpaket so 6 reproduktormi a subwoofer, rezervné
koleso (dojazdové) pre Sound Systém zdvihák +klúč na kolesá (možné iba s WNA)

PJC − 617 617

Alarm PD1/PD3 250 250 250

KESSY- systém bezkľúčového odomykania, zamykania a štartovania s alarmom a systémom
safe

PD5 − 446 446

Essence Selection Top SelectionKomfort

Essence Selection Top SelectionMultimédiá

Essence Selection Top SelectionZabezpečenie vozidla
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Modrá Energy *UNI 0 0 0

Biela Candy *SPE 350 350 350

Metalické farby *MET 526 526 526

Oranžová Phoenix, Červená Velvet *FLT 875 875 875

Chromová predná a zadná lišta nárazníka (možné len s PB1) YCA − 424 424

Color Concept Čierny -
nezahŕňa farbu vozidla

› Čierna strecha
› Čierne vonkajšie spätné zrkadlá
› Chrómované orámovanie prednej masky
(možné len s PJ5/PJ8)

WC1 − 238 238

Color Concept Sivý -
nezahŕňa farbu vozidla

› Sivá strecha
› Sivé vonkajšie spätné zrkadlá
› Sivé orámovanie prednej masky
(možné len s PJ6/PJ9)
(nie je možné s PTX/PTY/PTZ)

WC2 − 251 251

Predĺžená záruka na 5 rokov/100 000 km EA4 • • •

Predĺžená záruka na 5 rokov/150 000 km EA9 198 198 198

• Základná výbava − Nie je v ponuke MPManuálna prevodovka AP Automatická prevodovka

Servis 5 rokov / 75 000 km 750 1476

Servis 5 rokov / 100 000 km 972 2076

Servis 5 rokov / 150 000 km 1440 3330

Essence Selection Top SelectionOstatné

Basic ProfessionalServisné balíčky

www.skoda-auto.sk



Ponuka farieb a diskov

Oranžová Phoenix, metalická Červená Velvet, metalická Strieborná Brilliant, metalická

Modrá Race, metalická Biela Moon, metalická Čierna Magic, metalická

Sivá Grafit, metalická Modrá Energy, uni Biela Candy, uni

Oceľové disky 15"
s krytmi Callisto

Rotare 15”
strieborné

Rotare 15”
čierne

Proxima 16”
strieborné

Proxima 16"
čierne lesklé
s aero krytmi

Proxima 16”
sivé

s aero krytmi

Ursus 16”
čierne

Procyon 17"
strieborné

Procyon 17"
čierne lesklé
s aero krytmi

Procyon 17"
sivé

s aero krytmi

Libra 18"
čierne lesklé

www.skoda-auto.sk



Poznámky

Technické dáta vozidla nájdete v katalógu technických dát na stránke www.skoda-auto.sk.
Ceny uvedené v cenníku sú odporúčané ceny pre klienta v € vrátane DPH.
Doplnková výbava znamená bohatšie vybavenie vozidla, nie zdvojenú výbavu. Konečnú cenu, výbavu a jej
možnú kombinovateľnosť konzultujte s autorizovaným predajcom značky Škoda.
Spoločnosť Škoda Auto Slovensko s. r. o. si vyhradzuje právo zmeny cien a špecifikácií
bez predchádzajúceho upozornenia. Všetky obrázky sú ilustračné.

Cenník platný od 07.03.2024 (MR2024)

Spoločnosť Škoda Auto sa usiluje o zodpovedný, trvale udržateľný vývoj spoločnosti a šetrný prístup k životu a prírode.

Váš autorizovaný partner značky Škoda

www.skoda-auto.sk
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